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Hyperion Overview 

Overview 
 

Hyperion is a centralized, Excel and Web-based planning, budgeting and forecasting solution 
that integrates financial and operational fiscal processes and improves business predictability. 
Support Units and Responsibility Centers enter budget data through web forms using a web 
browser. Current year budget and two years of actual data are provided to facilitate the 
budgeting process. Support Units and Responsibility Centers can also choose to open these 
same forms in Smart View which is integrated into Excel to input and submit the budget through 
Excel or use the Smart View Ad Hoc functionality.   

 

Internet Option Setting 
 

Before you login to Hyperion, you need to change some Internet Option settings to smooth the 
access of Hyperion applications through the browser. IE 8 or 9 is the recommended browser.  
Internet Explorer 10 will not work. 

 

Pop-up Blocker 
 

1.  Go to Tools>Pop-up Blocker>Turn Off Pop-up Blocker: 
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Change the custom level of Trusted Sites 
 

2. Go to Tools>Internet Options. 
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3. Go to Security>Trusted Sites>Custom level. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTANT 

You need to repeat these steps for both Internet and Local intranet zones. 
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The Security Settings – Trusted Sites Zone window will popup.  
 

4. Scroll down to the Miscellaneous section. 

 

 
 

5. In the Miscellaneous section, enable Allow script-initiated windows without size or 
position constraints. 
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6. Continue scrolling down to the bottom, disable Enable XSS Filter. 

 
7. Click OK. 
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8. If a warning message displays, click Yes. 

 

9. Click OK again. 
 

IMPORTANT 

Remember, you need to repeat these steps for both Internet and Local intranet zones. 

 

10. Close and re-open your browser. 

 
 

Logging In 
  

The Hyperion budget submission application is incorporated to myUFL portal. After logging into 
myUFL, navigate to Budgeting > UF Hyperion Budgeting. 
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Hyperion opens with the HomePage displayed by default. 

 

NOTE: 
You may choose to display either the HomePage or the UBO_PSPB Application as the opening 
page by changing this setting in Hyperion User Preferences. 
 

NOTE: 

Also note that previous fiscal year data will appear on the HomePage.  For example, above you 
can see FY14PSPB.  As the years pass, you will see FY15PSPB, FY16PSPB, etc.  These 
applications are the view only data that was entered for that fiscal years submissions. 
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Setting Hyperion User Preferences 

 
Let’s look at how to setup user preferences before we begin using the application to prep and 
submit UF budgets. Setting user preferences allows you to define the default content that will 
display when you login to Hyperion (optional). It also allows you to define formatting, page 
options and additional options (mandatory). 

 

Changing Default Opening Page (This is an optional setting change) 
1. From the Hyperion application window, go to File > Preferences. 

 

2. If not already selected, select the General option in the list of options on the left side of 
the screen. This will allow you to select how the default content will display when you 
login to Hyperion. 

 

3. Click the Application drop down icon and select UBO_PSPB from the Planning list. 
 

4. Click OK.  
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Hyperion Budgeting 11 

Changing Hyperion Display Settings  
To change the display settings, you must first open the UBO_PSPB application.  The display 
options must be established prior to using the Hyperion application for requesting UF budgets.  

 

1. Open UBO_PSPB from the Quick Links section of the Home Page.  (If you’ve already 
changed the preferences to display UBO_PSPB immediately upon login, you would skip 
this step).  

 
NOTE: 
If you have previously opened the UBO_PSPB application, you can open it again from the 
Recently Opened section on the HomePage, if displayed. 

 
2. Choose File > Preferences from the Menu bar. 

 
3. From the Preferences window, select the Planning option in the list of options on the left 

side of the screen. 

 

4. Select the Display Options tab at the top of the screen. 
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5. Select your desired options. 
 

You are welcome to customize your desired Display Options settings as you see fit.  Some 
suggested default settings include: 

 

Number Formatting 

 Thousands Separator – choose Comma 

 Decimal Separator – choose Dot 

 Negative Sign – choose Prefixed Minus 

 Negative Color – choose Red 

 

Page Options 

 Indentation of Members on Page – choose Indent based on hierarchy 

 This option dictates the look and feel of data categories on web forms. 

 

Other Options 

 Warn if data form larger than cells specified – enter 50,000.   
This option will give you a warning message if the number of cells in the web form 
reaches the limit.  Raising this value to a fairly high number ensures lower limit 
breaches. 
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Changing Hyperion User Variable Settings  

As part of the Hyperion preference setup, you will indicate three User Variable settings These 
settings will not need to be changed again until the next fiscal year cycle. 

 

 Scenario: Budget  

 Version: Working  

 Year: FY15  
 

 
6. Click OK. 

You are now ready to navigate through the application.  
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Workspace 

Hyperion Navigation 
 

 

 

 

Toolbar Icons   
 

 Save Save the input data 

 Refresh Refresh  the form 

 Print Print the current screen 

 Adjust 
Adjust the selected cell value by a percentage or by a 
value  

 Grid Spread Spread value  

Menu Bar Tool Bar 
Content Area 

Open 
Application 

View Pane 
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 Mass Allocate Run a mass allocation  

 Comment Add or edit comment to the selected cell. 

 

Lock/Unlock 
Cells Lock or unlock cells when spreading data.  

 

Supporting 
Detail Add or edit supporting details to selected cell. 

 

Add/Edit 
Document Add or edit attached documents for the selected cell. 

 

Open 
Document Open the attached document for the selected cell. 

 Instructions Show the instruction details for the open data form. 

 

Open in Smart 
View 

Open data from in Smart View. (This button does not work 

and will not be used.) 

 

 

Some tools can be accessed by right-clicking on the desired area of the form and displaying the 
shortcut menu. 
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Hyperion Processes 
There are two specific and individual processes you will complete using Hyperion to 
successfully submit your budget each fiscal year.  Those processes include multiple procedural 
steps and are titled: 
 

 Budget Preparation 

 Budget Submission 

 

View Modes 
You will use Hyperion to prepare your budget by managing and calculating position and 
employee data first, and then to submit your budgets to the University Budget Office.  You will 
use two separate Views within the Hyperion application to do this. 
 

View Mode Purpose 

1. Basic To manage and calculate position and employee data, including salary 

2. Advanced To submit your All Funds Budget to the University Budget Office 

 
 

To Change View Modes: 
 

1. Choose View from Menu bar. 
 

2. Choose either Basic or Advanced as needed.  
 

  
  

 

 

 

 

UF 
Budget 
Office 
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Budget Preparation 

NOTE:  Choose File > Basic from Menu bar if needed. 
 

The annual Budget Submission process includes completing relevant procedures within both 
Budget Preparation and Budget Submission before submitting to the University Budget Office 
(UBO). 
 
In this section, we will cover the available procedures in Budget  Preparation in the order the 
University Budget Office recommends as best practice.  Required Budget Preparation 
procedures should be completed first, prior to completing Budget Request Submission 
procedures. 
 
There are a total of 15 budget prep procedures displayed in the image below from which you 
may choose to successfully prepare your budget. 
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Manage Position and Employee Data Forms 

 
Maintain position data 
This form should only be used to make changes to positions.  Updating employee distributions 
and data is performed within a different form. 

Maintain filled positions 
This form should only be used to make changes to existing and to-be-hired employees.  This is 
where you would make any changes to distributions, salary, benefits, etc. 

Maintain employees by position 
Maintain employees by position was originally designed to display positions and employees 
together in one form, but due to the level of complexity and resulting confusion, the UBO does 
not recommend using this form.  

 
Fill to-be-hired vacancies 
Fill to-be-hired vacancies can be used to display all to-be-hired positions for one entity and 
serves as a convenient location to see all of your to-be-hired positions.  Use of this form for its 
original intended purpose will not be covered in this course.  This functionality does not currently 
work correctly as Hyperion is currently being used at UF.  

 
 

  



Hyperion Budgeting 19 

Running Hyperion Reports 

Please keep in mind that the reports will not be updated until after the push has occurred in 
Hyperion.  The push runs every two hours starting at 7am and ending at 7pm Monday thru 
Friday.  On Saturday and Sunday the push will run every two hours starting at 11am and ending 
at 7pm. 
 
We have found that the push typically takes 1 hr to run.  We recommend you run the reports an 
hour after the push times (8am, 10am, et al.) to see any changes that were made before the 
push occurred.   
 

Navigation to all reports 
1. Log into myUFL and navigate through Main Menu > Enterprise Reporting > Access 

Reporting. 
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2. Select Budget > UF Budgeting. 
Once inside you will choose the report you want to run from the list provided. 
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Budgeted Lines + Benefits Report 
The Budgeted Lines + Benefits Report gives you a list of where all employees are currently 
budgeted and their benefits within Hyperion. This report can be run by the following additional 
search criteria Employee, Entity (Home Department), Comp Entity (Earnings Department), and 
Filled or Vacant.  Please note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), 
Comp Dept Flex (Earnings Dept Flex) are available search criteria.  We recommend that this be 
the first  step in the budgeting process so that you know how the people data was loaded into 
Hyperion at the time of the snap shot.  

 
1. Select Budgeted Lines + Benefits 

 
 

2. Choose your required search criteria. 

 
3. Choose your additional search criteria.  In this example, we will use HR_6201 data.  

After entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 
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5. Review your report. 

 
NOTE:  At this time each person has at least two rows of data.  The one row of data is the 
salary expense data line and the one row is the benefit data line.   
 

NOTE: You do not have to run all of the below reports before you continue on with your 
budgeting work this is just to show you how to run the additional reports that are available for 
your use. 
 

Additional Earnings + Benefits 
The Additional Earnings + Benefits Report gives you a list of any employee where that 
employee has had additional earnings and their benefits input into Hyperion. This report can be 
run by the following additional search criteria Employee, Entity (Home Department), Comp 
Entity (Earnings Department), and Filled or Vacant.  Please note Comp Fund (Earnings Fund), 
Comp Program (Earnings Fund), Comp Dept Flex 
(Earnings Dept Flex) are available search criteria. 

  
1. Select Additional Earnings + Benefits 
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2. Choose your required search criteria. 

 
3. Choose your additional search criteria.  In this example, we will use HR_6201 data.  

After entering scroll to bottom of form or top of the form. 

 
4. Click Finish and wait for the report to run. 
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5. Review your report. 

 

Benefit Selection 
The Benefit Selection Report gives you a list of all employees benefit selections that have been 
input into Hyperion. This report can be run by the following additional search criteria Employee, 
Entity (Home Department), Comp Entity (Earnings Department), and Filled or Vacant.  Please 
note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), Comp Dept Flex (Earnings 
Dept Flex) are available search criteria 

 
1. Select Benefit Selection 

 
 

2. Choose your required search criteria. 
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3. Choose your additional search criteria.  In this example, we will use HR_6201 data.  
After entering scroll to bottom of form or top of the form. 

 
4. Click Finish and wait for the report to run. 

 

 
5. Review your report. 
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Update Current Employees’ Distributions & Data 
 
NOTE: This procedure was formerly known as “Adjusting a Distribution”. 

NOTE:  Depending on your department size, you may get a large data warning.  Simply click 
Yes. 

 
This procedure is used to make changes to particular parameters of an employee’s distribution, 
such as changing an employee’s Entity. 
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1. From the Maintain filled positions form, choose your desired Entity from the Entity 
drop down field. 

 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 
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3. Click the Distributions tab. 
NOTE:  You may have to scroll to the right to view the Distributions tab. 

 

In this example, we will be changing the employee’s Entity and assigning the appropriate 
Chartfield String.  If any data is missing addressing these segments will clear the red cell color. 

4. Click the Entity Segment drop down field. 

5. Enter the desired Entity number into the Search field (e.g., "1302").   

NOTE: When searching, you do not have to type D_  in the Entity field.  You can just 
type in 1302 and the list should automatically move to the correct options.  You may also 
choose to scroll to the appropriate list item by using the green left and right arrows (see 
above). 

  



Hyperion Budgeting 30 

5. Click the new desired Entity. 

 

6. Click the Fund Segment drop down field. 

7. Click the desired Fund/Budget Reference/Source of Funds option (e.g., 101-CRRNT-
NO_SOF). 
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8. Click the Program Segment drop down field. 
 

9. Click the desired Program option (e.g., PRG_1100).  

 

10. If needed, click the Dept Flex Segment drop down field and select the appropriate Dept 
Flex option or choose/type No_Dept_Flex. 

11. Make any changes to the Allocation Start and End Dates if needed. 

12. If any changes are needed to the Percentage Allocation field, make those here.   
NOTE:  You must have a number in the percentage cell and all lines must be 100% in 
total.  Do not leave any 0% distribution lines. If you do not need that line please delete 
the allocation not being used.  

 
13. Click the Save button. 

NOTE:  If you had any red or yellow fields, they no longer appear once you save your 
changes. 
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Add an Additional Distribution for the same Employee 
It’s not uncommon for an employee to hold multiple positions or have multiple distribution 
sources at UF.  This procedure covers how to add an additional distribution for the same 
employee. 
 

1. From the Maintain filled positions form, choose your desired Entity from the Entity 
drop down field, if needed. 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 
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3. Click the Distributions tab. 
NOTE:  You  may have to scroll to the right to view the Distributions tab. 

4. Right-click the 1st Allocation label.  

 

5. Click the Add Distribution Information link. 

 

6. Enter the Effective Start or End Date if it’s different. 

7. Click the Add button.  
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8. Once the additional allocation appears, select an entity from the Entity drop down list 
and select the appropriate department from the list. 
NOTE:  You may need to search for the desired entity.  

NOTE:  Red cells indicate required data that is currently missing. 

 

9. Click the Fund Segment, Program Segment field, Dept Flex Segment, and Allocation 
Start and End Dates and enter the appropriate data.  Follow steps 7 – 11 from 
previous procedure, as needed. 

10. Make changes in the Percentage Allocation fields of both allocation lines. 

NOTE: Keep in mind, the combination of all distribution lines must equal 100% 
allocation.  Please do not leave any 0% distribution lines.  If it is not needed delete the 
distribution allocation. 

 

11. Click the Save button. 
NOTE:  Remember any red or yellow cells should clear after saving. 
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Delete a Distribution  
1. From the Maintain filled positions form, choose your desired entity from the Entity 

drop down field, if needed.

 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 
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3. Click the Distributions tab. 
NOTE:  You may have to scroll to the right to view the Distributions tab. 

 

4. Right-click the Allocation label you wish to delete.  
 

5. Select Delete Distribution Information. 

 

6. Click in the Percentage Allocation field of the remaining allocation. 

7. Enter "100". 
NOTE:  Remember, the lines must add up to 100. 

 

8. Click the Save button. 
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Calculate and Allocate Compensation Budgets per Edit 
After each edit you make, you may choose to calculate and allocate.  These procedures will 
process all needed calculations and allocate the updated data to the Budgets Submission mode 
within Hyperion. 
 
These procedures can take a long time depending on your area and number of employees.  As 
such the University Budget Office recommends you run these procedures from the Budget Prep 
panel once all edits/updates are done. 
 
If you choose to calculate and allocate after each edit, it’s very important that you note where 
you are before running these procedures as they are very sensitive to location to run accurately.   
 
For example, if you are on the main Maintain position data or Maintain filled positions forms, you 
must right-click on the exact position row you just edited for the calculate and allocate 
procedures to run successfully.  Otherwise, the edited data may not calculate and allocate 
correctly. 
 
If you are in Edit Employee Details, you can right click on any input cell on any tab (except for 
the General tab) to run the calculate and allocate procedures for this position. 
 

 
1. Right click in the correct area of the edited position. 
 
2. Click Calculate Compensation Expense. 

 
NOTE:  You will see an animated blue line within the Launch Business Rules window while the 
process is running.  See image below. 
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3. Confirm the calculation procedure was successful by noting the message that appears at 

the top of the window. 
 

 
4. After the Launch Business Rules window closes, right click within the same cell on the 

form again. 
 

5. Choose Allocate Compensation Budget to GL Accounts. 
 

 
NOTE:  The Launch Business Rules window will display again until the procedure completes. 
 

6. Confirm the procedures have completed successfully by noting the message that 
appears at the top of the form. 

 
 

 
 
 
 
 
NOTE:  Sometimes the Launch Business Rules window gets stuck.  If you notice the calculation 
or allocation has been running for several minutes, you can check to make sure the rule has 
finished running by clicking Tools>Job Console from the Menu bar.  If needed, scroll to the 
bottom of the window and click the End button. 
 
If the last column says “Completed”, the procedure has run successfully.  If not completed, you 
can click the Prev button and then click the End button again until the status changes to 
Completed.  
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Assigning an Existing Employee 
If you know you will be hiring a new current full time UF employee from another department 
before the snap shot was taken you will need to add them into Hyperion so that you can account 
for their salaries.  This process must be started by using the Maintain position data form and 
finished using the Maintain filled positions form. 
 
NOTE:  The snap shot is the status of the data in PeopleSoft on a particular date that is then 
loaded into Hyperion as the base data. 
 

1. From the Maintain position data form, right click the line of the position for which you 
want to assign an existing UF employee.  The available lines will say either Not 
Budgeted or Vacant. 

2. Hover over the Assign Employee option and click the Assign Existing Employee.  

 

3. Click in the Select Employee field, delete any default text and enter the UFID of the 
appropriate employee.  
NOTE:  the UFID must start with UFID_. 
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4. Enter the correct FTE, Effective Date, Union Code and Full/Part Time status, if 
different from position defaults.  
NOTE: All these fields are required. 

5. Click the Assign button.  

6. To confirm the change, click the Maintain filled positions form and verify the assigned 
employee data appears associated with the proper position.  

 

 
7. Right click on name of newly assigned existing employee and choose Edit Employee 

Detail to make any needed distribution and salary changes.   
 
8. Click Save button. 

NOTE:  Remember to run the calculations for changes to become active. 
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Assigning a To-Be-Hired Employee   
You would assign a To-Be-Hired employee for those positions not yet budgeted, but will be in 
the future or for new employees hired after the snap shot was taken.  To include the budget 
information for the future employee in your budget preparation procedure, you would assign a 
To-Be-Hired employee as a place holder. 
 
 

1. From the Maintain position data form, locate the position for which you wish to assign a 
To-Be-Hired employee.  

2. Notice the Occupancy Status for this position will indicate “Not Budgeted” or “Vacant”. 

3. Right click on the position and choose Edit Position Details. 

 

4. Click the FTE tab.  

5. Right-click anywhere in the blue area of the screen that states “No FTE assignments are 
defined”.  

6. Choose Update FTE.  
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7. Input the FTE for this position.  

8. Remove the Effective End Date.  
If you do not remove the end date it adds an unnecessary FTE line for the next available 
date sequence. 

9. Click Add.  

 

10. Confirm the assignment appears under the FTE tab. 
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11. Click the Maintain position data form again and notice your position should now read 
Vacant in the Occupancy Status field.  

12. Right-click the Position number.  

 

13. Point to the Assign Employee on the pop-up menu.  

14. Click the Assign To-Be-Hired Employee option.  

 

15. Enter the name of the new employee or a placeholder name or description if unknown.  
NOTE: If you know the UFID and want to input it best practice is to input it as 
UFID_XXXXXXXX  otherwise if you input a number only the system will treat it as a 
dollar figure and add a decimal and cents.  
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16. Be sure to indicate the correct Full/Part Time status, Union Code, FTE and Effective 
Date, if different from default.  

17. Click the Assign button.  

 

18. Note the message at the top of the window indicating the Position was filled successfully 
and the Occupancy Status of the position is now "Filled."  

 
 
 
 
 

 
 
 
 

19. Click on the Maintain filled positions form and find the To-Be-Hired employee just 
assigned. 

 
20. Right-click on the To-Be-Hired employee and choose Edit Employee Details. 
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21. If you changed the default FTE value in step 16 above, choose the FTE tab to ensure 

you have a valid FTE. 

 
22. Choose the Salary tab and ensure you have a valid salary.  If not, input the new salary 

dollar amount. If changes are made, be sure to save. 
 
23. Choose the Benefits Elections tab and ensure you have valid benefits and save. 
 
24. Choose the Distribution tab and input your distribution information and save. (See 

Procedure #2 above). 
 
25. Run both the Calculate and Allocate procedures.   
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Employee Status Change 
Common status changes are to inactive (due to maternity leave, military leave, retirement part 
way through the fiscal year, etc.)  

 
1. From Maintain filled positions form, right-click the relevant employee for which you are 

changing status.  
 

2. Click the Edit Employee Details.  

 

3. Click the Status Change tab.  

 

4. Right-click the blue assignment label of the assignment you wish to change.  

5. Click the Change Status option.  
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6. Click the Select Status drop down field. 

 

7. Click the appropriate status (e.g., Maternity, Inactive, On Sabbatical, etc.).  

8. Enter the desired information into the Enter Effective Start Date field (e.g., "12/1/14") 
and Enter Effective End Date as appropriate.  

9. Click the Change button.  
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10. Confirm the additional allocation displays with the appropriate Action. 

 

11. Go to Distribution tab and change the appropriate Allocation End Date to 11/30/14 to 
reduce the amount of salary expense being charged for this individual to the appropriate 
time period. 

 

12. Click the Save button. 

11. Run the Calculate Compensation Expense and Allocate Compensation Budget to GL 
Accounts.  

NOTE: The Calculate and Allocate process may take a few minutes.  

13. Right-click within any form cell to access the pop-up menu.  

14. Click the Return to Previous Data Form option.  
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Removing an Assignment 

 
NOTE:  This procedure previously referred to as Deleting an Employee. 
 

1. From the Maintain filled positions form. 
 

2. Right-click the Name of the individual of which you want to delete. 
 

3. Select Delete Employee Assignment.  
 

 
 

4. Once the process has run you will now notice that the employee is no longer listed in the 
Maintain filled positions form. 

 
 

Change FTE 
 

Occasionally the Full Time Equivalency (FTE) of a position or person may change.  Examples 
are full-time positions changing to part-time, part-time positions changing to full time or a 
different part-time status.   
 
NOTE:  The example displayed in this procedure was previously referred to as Change FTE 
from 1 to .5. 
 
NOTE:  Prior to completing the Change FTE procedure, please check the Default Weekly Hours 
cell to ensure you are adjusting your FTE correctly.  Default Weekly Hours listed as 40 is 
equivalent to 1.0 FTE.  Be aware that some employees have default weekly hours of 20 (not 
40).  The equivalent FTE for this would still be 1.0, not 0.5.  If you inputted 0.5, that would be 
equivalent to 10 hours, not 20. 

 
FTE may be changed either per position or per employee. 



Hyperion Budgeting 50 

To change the position FTE only. 
1. From the Maintain position data, right click on the position to which you wish to change 

the FTE.   
 

2. Click the Edit Position Details option. 

 
 

3. Click the FTE tab. 
 

4. Right-click in the Proposed FTE field. 
 

5. Select Update FTE from the pop-up menu.  
 

 
 

 

In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 
 
6. Replace the 1 in the Enter FTE field with .5. 
 
7. Select the default data in the Effective End Date field. 
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8. Press [Delete] to remove the Effective End Date to make this an ongoing change. 
 

9. Click the Add button. 

 
10. Confirm the assignment updates correctly. 

 

 
 

To change the FTE for an employee. 
 

1. From the Maintain filled positions, right click on the name of the individual you wish to 
change the FTE.   

 
2. Click the Edit Employee Details option. 

 
3. Click the FTE tab. 

 
4. Right-click in the Proposed FTE field. 

 

5. Select Update FTE from the pop-up menu.  
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In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 
 
6. Replace the 1 in the Enter FTE field with .5. 

 
7. Select the default data in the Effective End Date field. 

 
8. Press [Delete] to remove the Effective End Date to make this an ongoing change. 

 
9. Click the Add button. 

 
10. Confirm the assignment updates correctly. 
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Promote a Position and employee, including Fringe Benefit changes 
This procedure would be used when you are hiring a new employee and do not have an 
appropriate vacant line for that position.  You can use any one of the vacant lines you have and 
change the Job title and, if needed, change the Salary Admin plan which adjusts the Fringes.    

 
1. From the Maintain position data form, select the vacant position for which a promotion 

will be provided. 
 

2. Click on the job name cell. 
 

3. Click the job drop down arrow. 

 
4. Use the Search field to search for a position name or job number. 

 
5. Once found, select the position name or job number you want. 

  
NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
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6. Click the Save button. 

 
7. If no additional changes are needed to this position, skip to step 24.   

 
In this example, we need to change the benefits from a TEAMS rate to a Faculty rate. 
 
 
Change the Salary Admin Plan 
 

8. Right-click on the newly changed position.  
 

9. Choose Edit Position Details. 
 

 
10. Click the Salary tab.  Notice the Salary Admin Plan still says TA12 which is a TEAMS 

salary admin plan. 

 
11. Click the Fringes tab and notice the fringes are Teams fringe rates. 

 
 

12. Go back to the Salary tab and right click on any of the cells in the Position Details 
section. 
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13.  Click Delete Salary Information. 

 
 

14. Click the Delete button from the Delete Salary Information pop up window. 

 
15. Right-click on any cell in the Position Details section and choose Add Salary 

Information to add a new salary admin plan. 
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16. Click the Salary Grade Select Members icons to search for and locate the appropriate 
salary grade for this position. 

 
 

In this example, we will choose FA09, which is a 9 month faculty Salary Admin Plan. 
 
17. Expand the Salary Grades and Faculty categories, and then click FA09. 

 
18. Once FA09 is chosen click the right arrow to send it over to the Element area on the 

right hand side and then click OK.  
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19. From the Add Salary Information window, adjust your Effective Start Date if needed.  In 
this example, we will leave it at 7-1-2014. 
 

20. Click the Add button. 
 
After adding the new salary, you must run the Calculate Compensation Expense for the new 
Fringe Benefit to be reflected. 
 

21. Right-click on any cell in the Position Details section and choose Calculate 
Compensation Expense.   

 
 

22. Go to the Fringes tab and notice the fringes are now Faculty fringes. 

 
 
 

Promote an Individual 
 

23. Click Maintain filled positions from the Budget Prep panel. 
 

24. Click on the job name and select the drop down arrow. 

  
25. Use the top field to search for a position name or job number. 

 
26. Click the position name or job number you want. 



Hyperion Budgeting 58 

 
 

NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
 

27. Click the Save button.  
 

You will update the Salary and Fringe benefit, if needed. 
 

28. Right-click on the name of the employee holding newly changed position.  
 

29. Choose Edit Employee Details. 

 
30. Repeat steps 10 – 22 above as needed. 

 
31. Click the Save button. 

 
32. Run Calculate compensation budgets and Allocate compensation to general ledger 

accounts as needed. 
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Add Overtime Pay or Additional Earnings  
This procedure allows you to apply overtime or additional earnings to an employee’s salary 
information.  Examples of when overtime or additional earnings would be if you have a person 
that will need to work overtime, SPI, or is a Sr. Level manager and has additional earnings they 
receive. 

 
1. From Maintain filled positions, right click on the name of the person to whom you 

want to add overtime.  
 

2. Click the Edit Employee Details option. 

 
3. Click the Additional Earnings tab. 
 
4. Right-click on the blue section that states “Right-click and add Additional Earnings 

Elements portion of the screen.” 
 

5. Click the Add Additional Earnings option. 
 

 
6. Click the Enter Additional Earning Select Members drop down icon.  
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7. Click the Display Properties icon. 
 

8. Click the Alias menu.  

 
9. Select OTS Overtime. 
 
NOTE: In this example we are selecting an overtime payment.  You would choose the 
correct additional earnings for our purpose. 

 
10. Click the right arrow to move the item to the right side. 

11. Click the OK button. 
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12. If you want to make this effective as of July 1, 2014, click inside the Effective Start Date 
field. For example, change the date to "7-1-2014". 

 
13. Click the Add button. 

 

 
14. Click in the Override Option Value field and enter the Amount of the additional 

earnings. For example, enter "500.00". 
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15. Click the Option End Date field and enter the date this option amount will end. For 
example, enter "7-30-14". 

 

 
 

16. Click the Value Type Input field and a drop down list will appear. Select Amount - July. 

 
 

17. Click the Save button. 
 

  



Hyperion Budgeting 63 

Add a Vacant Position  
If you want to hold a specific dollar amount, but do not plan to hire someone in the near future 
for a specific position you can add a truly vacant line to hold dollar amounts.   

 
1. From the Maintain position data form, find a Not Budgeted or Vacant position. 

 
2. Right-click on the position and choose Edit Position Details. 

 
3. Click the FTE tab and verify the correct FTE is listed. 

 
NOTE: If you do not have a FTE or an inaccurate FTE is currently listed you will need to input 
the correct FTE by completing the following steps: 

a. Right-click anywhere on the assignment line. 
 

b. Choose Update FTE. 

 
c. Enter the appropriate FTE. 

 
d. Click the Add button. 
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NOTE:  If you permanently wanted to change the FTE of this position, you would delete the 
Effective End Date.  Otherwise, the updated FTE will return to the previous value after that end 
date passes. 
 

4. Click the Salary Tab. 
 

5. Input a Salary amount to hold in the Override Option Value cell.  Please keep in mind 
that the fringes will automatically calculate so if you have an exact amount you need to 
hold adjust the number you input for fringe benefits. 

 
6. Click the Save button. 

 
7. Go to the Distribution tab and input your distribution information and save.  (See 

Procedure #2 above). 
 

8. Run both the Calculate and Allocate procedures.   
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Calculate and Allocate Compensation per Entity  
In Hyperion you have the option of calculating and allocating after each edit or once all edits 
have been completed.  It’s recommended that the last procedures you complete as part of the 
Budget Prep process is to run the Calculate compensation budgets and Allocate compensation 
to general ledger accounts procedures. 
 
After all edits are complete, from the Budget Prep panel: 

1. Run Calculate compensation budgets once 
2. Run Allocate compensation to general ledger accounts as many times as needed 

depending on the number of edits that involved Filled, Vacant or To-be-filled employees 
or positions. 

 
For example, let’s say you made 10 edits of which 4 were filled positions, 2 were to-be-hired 
positions and 2 were vacant positions.  You would run the Calculate compensation budgets 
once to run all needed calculations of those 10 edits.  You would run the Allocate compensation 
to general ledger accounts three times – one for each type of edit to employees or positions 
made. 
 
 
BEST PRACTICE  
Because of the amount of time it takes for the system to complete the running of these options, 
UBO recommends running this at the end of your edits, rather than after each edit.  The amount 
of time the calculations require will depend on the number of employees that you have in your 
department or college.  The larger the department or college, the longer the calculations will 
take. 

1. Under the Calculations menu item, select Calculate compensation budgets menu 
item.  

 

2. Click the Launch button.  
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In this example, we show calculating and allocating the Working budget.   

3. Make sure Version is set to Working. 

a. Select the Version Select Members icon. 

 

b. Select Working from left Member Name list.  

c. Click the right-pointing Select arrow to move the Working version to the right 
side  Member Name list.   
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d. Click OK.

 

4. Make sure Scenario is set to “Budget.” 

a. Select the Scenario Select Members icon.  

  

b. Select Budget from the left Scenario list. 

c. Click the right-pointing arrow to move the Budget scenario to the right Scenario 
list. 
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d. Click OK.  

 

5. Select the appropriate Entity Select Members icon.  

 

a. Click your Department or College to select it.  

b. Click the right arrow to place it on the right side of the screen.  
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c. Click the OK button.  

 

6. Click the Launch button.  
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NOTE: The blue line across the time will ping-pong back and forth until the process is done.  
This many take several minutes to process. 

 

NOTE:  A message displays at the top of the window to indicate the process was successfully 
run. 

 
6. Once you see the rule was run successfully, click the Allocate compensation to 

general ledger accounts option in the left panel.  

7. Click the Launch button.  
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The Allocate compensation to general ledger accounts procedure makes all edits available to 
the general ledger and after “the push” will be available for Budget Request Submission 
procedures. 

IMPORTANT! 
You will run this procedure multiple times depending on the types of edits you’ve made to the 
positions in the Maintain position data form and the Maintain filled positions data form. 

The type of edits you completed during the Budget Prep process will determine how many times 
you will need to run the Allocate compensation to general ledger accurate procedure. 

For example, if you made 3 edits to the positions/employees that were filled, to-be-hired, and 
vacancy, respectively; you will run the Allocate compensation to general ledger accounts 
procedure three times to allocate all position edits to those three types of positions. 
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To Allocate To-Be-Hired Positions 
 

8. Select the appropriate employee. 

a. Click the Employee Select Members button.  

 

b. Click the Total Employees expand icon to expand the list, if needed. 

 

c. Select New Employees from the left Employee Member Name list. 

d. Click the right-pointing Select arrow to move it into the right side of the 
window.  

e. Click the OK button.  
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9. Select the appropriate entity. 

a. Click the Entity Select Member icon. 

  

b. Click the Expand icon next to the appropriate Entity category.  
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c. Select the appropriate Entity.  

d. Click the right-pointing Select arrow to put it in the right side of the window.  

e. Click the OK button.  

 

10. Make sure All Positions is chosen. 

a. Click the Position Select Members icon.  
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b. Select All Positions from the left Positions list.  

c. Click the right-pointing Select arrow to move it to the right side of the screen.  

d. Click the OK button.  

 

NOTE:  It’s important to choose All Positions.  If you leave the default Position # or indicate a 
specific position, only that position data will allocate. 

11. Make sure to choose Budget. 

a. Select the Scenario Select Members icon.  
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b. Select Budget from the left Scenario list. 

c. Click the right-pointing Select arrow to move it to the right side of the screen. 

d. Click OK. 
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12. Confirm you are working on the correct budget Version. 
NOTE:  Change to appropriate version if needed. 

 

13. Click the Launch button.  

  

14. The blue bar will continue to ping-pong back and forth while the process is running.  
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15. Confirm the process runs successfully by noted the message that appears at the top of 
the window.  

 

If you have edited positions with Vacancy or To Be Filled, you will need to run the Allocate 
compensation to general ledger accounts procedure for each category. 
 
 
To Allocate Vacancy Positions 
 

1. Complete steps 10 - 13 from the above procedure. 

2. Select Vacancy from the left Employee list. 
 

3. Click the right-pointing Select arrow to move it to the right side of the window. 
 

4. Click the OK button. 
 



Hyperion Budgeting 79 

 
5. Complete steps 10 – 15 of the To Allocate To-Be-Hired Positions process starting on 

page 75. 
 
 
To Allocate Filled Positions 
 

1. Complete steps 10 - 13 from the above procedure. 

2. Click the Existing Employees expand arrow from the left Employee list. 
 

3. Click the appropriate Sr. VP or VP your area falls under and choose the expand arrow. 
 

4. Click the appropriate College or Unit 
grouping expand arrow. 
 

5. Select the appropriate department 
sub-group. 
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6. Click the right-pointing Select arrow to move it to the right side of the window. 

 
7. Click the OK button. 

 

 
 

8. Complete steps 10 – 15 of the To Allocate To-Be-Hired Positions process starting on 
page 75. 
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Review Allocation Results 
To confirm the data has been processed successfully, you'll review a report to show you what 
was processed.  
 

1. Click the expand arrow next to Review entity compensation budgets to view the 
reports available.  
 

2. Click the Review Allocation Results option.  

 

3. View the results to make sure the Allocation process was run.  

 
In this example, you can see that position P_00005478 is displaying an error.  
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Correct Allocation Errors 
Whenever you see red cells in the Review Allocation Results report, that means you have an 
error somewhere with this person/position. 
 
Common errors are: 

 Allocate compensation to general ledger accounts procedure was not run 

 FTE not assigned 

 No distribution assigned 

 Distribution does not equal 100% 

 Earlier than accepted Distribution End Date 
 

1. From the Review Allocations Results report, right click on employee name. 
 

2. Choose Edit Employee Details. 
 

 
3. Check the FTE and Distribution tabs to check if above issues are found. 

 
4. If nothing appears within the FTE and Distributions tabs, calculate and allocate again. 

 
5. Confirm the error has been fixed. 

 
NOTE:  Position number P_00005478 no longer displays the red cell. 
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Prior to submitting your requested budgets, the Push has to occur.  This will occur every 2 hours 
from 7 AM – 7 PM, Monday – Friday.  On Saturday & Sunday, the push will occur every 2 hours 
from 11 AM – 7 PM 
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All Funds Budget Submission 

NOTE:  You must be in Advanced Mode to work on the All Funds Budget Submission.  After the 
Push has occurred, Choose File > Advanced from Menu bar if needed. 
 

 
 
 

 

 
Forms for Budget Submission 
 
Accessing Forms 
 

1. Click on the “+” on the left hand side of Forms folder to expand.  

2. Click on the All Funds Budget.  

3. In the content area, you should see four forms. 

 Budget Worksheet  

 Budget Worksheet-Level 0 Accounts Only  

 Control Amount Used 

 HCP Push Validation 
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HCP Push Validation 
This forms allows you to verify that “the push” has successfully completed and will display the 
salary dollars entered via Budget Prep.  You should verify this information prior to using the 
other two forms. 
 

1. Select HCP Push Validation form. 
 

2. Choose your Entity from the Entity dropdown field. 
NOTE:  You may need to search for the appropriate Entity. 
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3. Choose your FundBudRefSOF from the FundBudRefSOF drop down field. 

 

 
4. Choose your Dept Flex from the Dept Flex drop down field. 

 
NOTE:  If your ChartField string does not include Departmental Flex, this field must display “No  
Department Flex”.  Type in “no de” into the search field, then choose No Departmentl Flex from 
result list. 

 
5. Choose the appropriate program from the Program drop down field. 
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6. Click Go button. 

 
Verify the displayed data is what you expected to see pushed from Budget Prep.  If the data is 
unexpected or in error, return to Basic Mode and Budget Prep and make any needed 
corrections. 
 
 

Budget Worksheet 
Salary data and fringe will automatically be populated from the Budget Prep push.  

 

This form displays account categories and accounts that expand and roll up along with totals at 
the bottom of the columns. Please note either this form or the Budget Worksheet – Level 0 
Account Only form can be used to input budget.  Both forms do the same thing they just have a 
different view. 

 

This form provides two years of actual expenditures, partial expenditures for the current fiscal 
year, and current year final approved budget.  The actual data include your expenditures only.   

NOTE: It is not required to budget at the 8 digit DeptID level or GL account level. It is your unit’s 
decision what level to budget. However, all data must be input at Level 0 members.  Your State 
Appropriation funds will be released at whatever level you budget here so please make sure you 
budget at whatever level you want your State Appropriations released at for the next fiscal year. 

 

If you plan to budget at a higher level, you also need to select one 8 digit DeptID. For example 
Enrollment Management, if you plan to budget at Office of Admission, Office of Registrar’s 
Office and VP of Enrollment Management areas, you can select DeptID 03020000 for Office of 
Admission, DeptID 03030000 for Office of Registrar and 03010000 for VP of Enrollment 
Management. You don’t have to go down to 03020100 or 03020300 deptID level. 

 

Similarly, if you plan to budget at GL account level, select the GL accounts you need to budget 
to and input your value. If plan to budget at higher level, for example, if you want to budget at 
Contractual Services level, pick one GL account under Contractual Services and input your 
value. You can either pick the GL account where you spend most of the Contractual Services or 
pick the GL account “71000 - Contractual Services”.  We will release State Appropriations at the 
600000 650000 and 700000 categories as we have in the past. 

 

1. Select your Department from the Entity drop down field (if needed). 
 

2. Select the appropriate FundBudRefSOF, Dept Flex (if needed) and Program. 
 

3. Then click the Go button.  
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NOTE:  The upcoming fiscal year appears first in the workspace, following by the previous 3 
fiscal years. 
 
The upcoming fiscal year will display 3 budget columns:  

 Control – this is the initial budget the Budget Office inputs for the new fiscal year 

 Working – this is your working budget.  This is where you amake your plans for 
spending for the fiscal year. 

 Final – this is your final, confirmed budget for the fiscal year and the Budget Office will 
populate this column once everything has been finalized. 

 

Seeding Budgets 
Seeding budgets allows you to take budget data from current or previous fiscal year(s) and 
populate your Working budget for the upcoming year.  This process allows you to quickly add 
data to use as a starting point for budgeting without having to manually enter large amounts of 
budget data. 
 

1. Right-click the upcoming fiscal year Working budget column header. 
 

2. Point to Seed Budget…from menu. 
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3. Click from Current year (YTD) Actual. 

 
4. Scroll down to confirm non-salary accounts have seeded correctly. 

NOTE:  you will notice that Salary account (600’s) do NOT reflect the data from the 
current year Actual.  Salary data is pushed over from Budget Prep and is not editable in 
All Funds Budget (Budget Submission).  If you wish to make a change to salary data, 
you must return to Budget Preparation and make the change there. 
 
OPS and Operating Cost account should display the seeded data from the chosen fiscal 
year. 
 

5. After confirming your Working column has been seeded correctly, click the Save button.  

 

NOTE:  Data may be entered manually into any white cell, instead of seeding, if desired. 
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Budget Worksheet-Level 0 Accounts Only 
Salary data and fringe will be automatically be populated from the Budget Prep push.  

 

This form only displays accounts and the accounts don’t expand (roll up).  You will also not see 
totals at bottom of columns. Please note either the Budget Worksheet form or this form can be 
used to input budget.  Both forms do the same thing they just have a different view. 

 

This form provides two years of actual expenditures, partial expenditures for the current fiscal 
year, and current year final approved budget. The data in this form is read-only. The final 
approved current year budget data is based on your budget in Budget Prep (salary portion) and 
All Funds Budget (OPS and other expenditure portion).  

 

NOTE: It is not required to budget at the 8 digit DeptID level or GL account level. It is your unit’s 
decision what level to budget. However, all data must be input at Level 0 members.  Your State 
Appropriation funds will be released at whatever level you budget here so please make sure you 
budget at whatever level you want your State Appropriations released at for the next fiscal year. 

 

If you plan to budget at a higher level, you also need to select one 8 digit DeptID. For example 
Enrollment Management, if you plan to budget at Office of Admission, Office of Registrar’s 
Office and VP of Enrollment Management areas, you can select DeptID 03020000 for Office of 
Admission, DeptID 03030000 for Office of Registrar and 03010000 for VP of Enrollment 
Management. You don’t have to go down to 03020100 or 03020300 deptID level. 

 

Similarly, if you plan to budget at GL account level, select the GL accounts you need to budget 
to and input your value. If plan to budget at higher level, for example, if you want to budget at 
Contractual Services level, pick one GL account under Contractual Services and input your 
value. You can either pick the GL account where you spend most of the Contractual Services or 
pick the GL account “71000 - Contractual Services”.  We will release State Appropriations at the 
600000 650000 and 700000 categories as we have in the past. 

 

1. Select your Department from the Entity drop down field (if needed). 
 

2. Select the appropriate FundBudRefSOF, Dept Flex (if needed) and Program. 
 

3. Then click the Go button.  
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NOTE:  The upcoming fiscal year appears first in the workspace, following by the previous 3 
fiscal years. 
 
 
The upcoming fiscal year will display 3 budget columns:  

 Control – this is the initial budget the Budget Office inputs for the new fiscal year 

 Working – this is your working budget.  This is where you amake your plans for 
spending for the fiscal year. 

 Final – this is your final, confirmed budget for the fiscal year and the Budget Office will 
populate this column once everything has been finalized. 

 

Seeding Budgets 
Seeding budgets allows you to take budget data from current or previous fiscal year(s) and 
populate your Working budget for the upcoming year.  This process allows you to quickly add 
data to use as a starting point for budgeting without having to manually enter large amounts of 
budget data. 
 

1. Right-click the upcoming fiscal year Working budget column header. 
 

2. Point to Seed Budget…from menu. 

 
3. Click from Current year (YTD) Actual. 

 
4. Scroll down to confirm non-salary accounts have seeded correctly. 

NOTE:  you will notice that Salary account (600’s) do NOT reflect the data from the 
current year Actual.  Salary data is pushed over from Budget Prep and is not editable in 
All Funds Budget (Budget Submission).  If you wish to make a change to salary data, 
you must return to Budget Preparation and make the change there. 
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OPS and Operating Cost account should display the seeded data from the chosen fiscal 
year. 

 
5. After confirming your Working column has been seeded correctly, click the Save button.  

 

NOTE:  Data may be entered manually into any white cell, instead of seeding, if desired. 
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Adding Missing Accounts 
The adding missing accounts procedure allows you to add accounts that were not previously 
used but will be needed and used in the future. 

 

1. Within the Content Pane on the left side of your screen, you will see a rule labeled 
OPERBUD- PopulateAccount. 
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2. Double-click the OPERBUD-PopulateAccount rule. 
 

From the Runtime Prompts window, indicate the account you wish to add. 

NOTE: Do NOT change any of the other fields in this window.  

 
3. Click the Account Select Members button. 
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You will drill-down and locate the account you wish to add within the left Member Name column. 
NOTE: When adding OPS Salary accounts please choose the second choice in the list as the 
first choice in the list is the pre-fringe benefit pool account and this account is no longer active.  
You will not be able to input data into this account cell once added. 

 

In this example, we are going to add an additional Travel account. 

 

4. Click the Total Accounts Expand icon. 
 

5. Click the Net Revenue and Expense Expand icon. 
 

6. Click the Total Expense Expand icon. 
 

7. Click the Operating Expenditures Expand icon 
 

8. Click the Other Operating Expenses Expand icon 

 
9. Scroll down, as needed.  
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10. Click the Travel and Training Expand icon. 

11. Click the 771005 object. 

 

12. Once you have located the desired account, you will move it to the right side Member 
Name Column. 
 

13. Only the accounts listed on the right side will appear in your worksheet. 
 

14. Click the Right-pointing Select arrow. 
 

15. Confirm the correct account appears on the right side. 
 

16. Click the OK button. 
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17. Click the Launch button. 
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18. After launching the rule, you will receive a confirmation message. 
 

19. Click the OK button.  

 

20. Click the Refresh button from toolbar. 

 

21. Scroll down to verify the new account has appeared in your worksheet. 
 

22. Notice the new account now appears in the Travel and Training section. 
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23. Click within the Foreign Travel cell of the appropriate budget column. 
 

24. Enter the amount you wish to budget for that acount.  For this example, enter “100”. 
 

25. Click the Save button. 
 

NOTE:  This account will remain in your worksheet as long as you budget for it by placing a 
value in the cell. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visable (as long as you did not suppress zeros in your user 
preferences) for the current fiscal year. 

 

 

Comments, Supporting Details and Documents 
To elaborate on or explain the data entered into any cell, you may choose to add comments, 
supporting details or documents to the appropriate cell. 
 

Adding Comments 
 

1. Right click on the cell to which you wish to add a comment. 
 

2. Choose Insert Comment. 

 

3. Type in the desired comment. 
 

4. Click the Submit button. 
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You can tell a cell has a comment attached by noted the icon that appears in the upper, right 
corner of the cell. 

 

Editing Comments 
 

1. Right-click the cell that has a comment. 
 

2. Click the View Comment option.  
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3. Change your comment as needed. 
 

4. Click the Submit button. 

 

Deleting Comments 
 

1. Right-click the cell that has a comment. 
 

2. Click the Delete Comment option.  

 

3. Scroll down to confirm the cell no longer displays the icon in the upper, right corner. 

 

NOTE: Comments can be added to a level 0 member or parent member. 
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Supporting Details 
This function allows you to add calculations or aggregate lines to your budget cells. For example 
Travel and Training, you can add the airfare cost, lodge, meals etc. to the cell as supporting 
details. 

 

Adding Supporting Details 
 

1. Right-click in cell to which you wish to add supporting details. 
 

2. Select the Supporting Detail option. 

 

The Supporting Detail window will pop up for you to enter the supporting detail. 
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You can add as many detail lines as needed.  In this example, we will add Airfare and Hotel 
costs. 

 

3. Type in the description of the first detail line in the Untitled field. 
 

4. Tab over and type in the amount of this detail line. 
 

 
5. To add an additional line on the same level, choose the Add Sibling button. 
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6. Type in a description for the second detail line. 
 

7. You will click the Add Child button if you need to include a calculated detail line.  In this 
example, we will input the calculations that contribute to the lodging costs. 

 

NOTE:  A child detail line will appear slightly indented from the previous parent line. 

 

8. Type in the description of the child line. 
NOTE:  In this example, we are calculating 32 days of lodging at $125 per night. 
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9. Click the Add Sibling button to add an additional detail line directly below Hotel Rate. 

 

10. Add the appropriate description for the new detail line. 
 

11. Select the appropriate operator symbol for the calculation. 
NOTE:  In this example, we will be multiplying the Number of Days by the Hotel Rate to 
determine the expected In-State travel expenses for the Working Cut budget. 
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12. Enter the appropriate number of expected travel days. 

 

NOTE:  The Total field will automatically calculate. 

 

13. When all supporting details have been entered, click the Save button. 

 

14. Scroll down and notice that the cell(s) with the supporting detail will now be blue/green. 
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NOTE:  You can also tell if a cell has supporting details attached, by pointing to the blue/green 
cell and noticing the message that appears. 

 

Editing/Deleting Supporting Details 
 

1. Right-click the cell that has the Supporting Details you want to edit or delete. 
 

2. Choose Supporting Detail. The supporting detail window will pop up for you to edit or 
delete. 

 

3. Edit the values as needed or click the appropriate Delete button (Delete or Delete All). 
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NOTE:  Clicking Delete All will remove all Supporting Details from the cell. 

 

4. Click the Save button. 

 

After saving, you will determine whether you wish to remove the value and the supporting 
details from the cell on the main screen, or just delete the supporting details. 

 

 Choosing Yes  all data will be removed, including the cell value. 

 Choosing No  only the supporting details will be deleted. 

 

In this case, we will remove the supporting details, but leave the value in the cell. 

 

5. Choose No, leave the value as it is. 
 

6. Scroll down and confirm the supporting value has been removed from the cell(s). 
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Adding Documents 
This function allows you to attach a document to a cell. You need to import the document file 
into Hyperion first.  Once in Hyperion, you can then add the file to any desired cell. 

 

Import files into Hyperion 
 

1. Click on Explore button from Menu bar. 
 

 
2. Notice a new Explore tab will be added to the content area: 

 

You should see a folder created for your support unit. For example, Human Resources will see 
a folder for Human Resource. This is the only folder you have access to. You have full control of 
this name. You can add, edit or delete files in this folder. 
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3. Select your folder, go to File > Import > File. 

 

 

4. A new window will pop up. Click the Browse button. 
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5. Navigate through your file system, select the file you want to import, click Open. 

 

 

6. Click Next button. 
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7. Click Next button. 

 

 

8. Click Finish button. 

 

NOTE: You can assign permissions to selected users to allow other users to view or update this 
file. If you don’t want to grant any access to other users, click “Finish”. The file is attached. 
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To grant permssions to others: 

a. Select the search value of either User ID, First name or Last name. 

b. Decide how to search as either begin with, contain or are in group. 

c. Type in the value for which you are searching. 

d. Click Update List button. 

e. Select the name in the left Name column. 

f. Click the right pointing selection arrow. 

g. Confirm appropriate person(s) appear in Selected Users, Groups and Roles 

section. 

h. Select each person and choose the appropriate access level from the 

Access drop down field.  Options are: no access, view, modify and full 

control. 

 

i. Click the OK button. 
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Adding Documents 
 

You are now ready to add the file to a cell.  

 

1. Right-click the cell to which you wish to add the document. 
 

2. Choose Add/Edit Document. 

 
3. Click the Browse icon from the Add/Edit Document window. 
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4. Double-click your folder to open it. 

 

5. Select the desired file and click OK. 
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6. Click Submit on the Add/Edit Document window. 
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7. Scroll down and confirm the file is attached.  You will see an icon in the upper, right 
corner of the cell. 

 

NOTE:  When you mouse over the cell, you will also see a message indicating a document is 
attached. 

 
 
Opening Documents 
 

1. Right-click on the cell that contains the document you want to open. 
 

2. Click the Open Document option. 

 

3. Click Open. 
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NOTE:  If the document is Excel file, the file will open in Excel. You will see login screen popup 
(it may pop up a few times), Click “Cancel”, the file will open in Excel. Open document function 
doesn’t always work. Enterprise Systems is aware of this issue and working on the resolution.  

 

Removing Documents from the Worksheet 
 

1. Right-click the cell that contains the document you wish to remove. 
 

2. Click the Add/Edit Document option. 

 
3. Click the Clear button from the Add/Edit Document window.  
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4. Click the Submit button. 
 

5. Scroll down and confirm the file has successfully been removed. 
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Deleting Documents from Hyperion 
 

1. Click the Explore button from toolbar. 
 

2. Open your folder, right-click the file and choose Delete. 

 

NOTE: You can attach many types of documents such as Excel, Word, PDF, etc.  
Documents can be attached to level 0 member or parent member. 
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Control Amount Used 
This form is used to confirm that the total expense lines for both the Control and Working 
budgets equal.  After spreading budget dollars and before sending to CFO, you should confirm 
both budgets balance. 

 

If they do not equal, spread adjustments will need to be made prior to submitting to CFO. 
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Smart View 

Opening Smart View 
Smart View allows you to access and work in the same Hyperion forms in a more familiar Excel 
environment. Smart View is a plugin that must be installed on your computer prior to use.  
Contact your tech support if you need Smart View installed. 

 

1. Open Excel and verify you can see a Smart View tab at the top of the application 
window. 

 

 

Setting up Smart View Shared Connections URL 
Prior to using Smart View to complete all needed Budget Request Submission procedures, you 
will set up the appropriate Smart View connections. 
 

1. Click the Smart View tab, click the Options button and then select Advanced. 

 
  

 
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2. Type or paste the below URL in the Shared Connections URL field:  
 
https://prd-budget.erp.ufl.edu/workspace/SmartViewProviders.  
 

3. Click OK. 

 
 
 
 

  

https://prd-budget.erp.ufl.edu/workspace/SmartViewProviders
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Smart View Option Settings 
By default, missing data are displayed with #Missing. You can change the default display to 
other characters such as “-“. You can also make other formatting changes to Smart View. 
 

1. Click the Smart View tab, select Options, and select Data Options. 

 
  

Suppress rows that have no data. 

Suppress zeros. 

Suppress columns that have no data. 

 Display #Missing 
as other 
characters. 
Suggest to use “-” 
instead of “0”. 
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Connecting to Hyperion in Smart View 
You are now ready to connect to Hyperion using Smart View. 
 

1. Click the Smart View tab, click the Open button, and then click Smart View Panel. 

 
 

2. Select the Shared Connections option from the Smart View Home panel. 
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3. Type your GatorLink Username and Password. Click the Login button. 

 
 

4. Select “Oracle Hyperion Planning, Fusion Edition” from the Shared Connections 
Select Server drop down field. 
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You should see the Hyperion server at the top of the Shared Connections panel.  
 

5. Expand each level as follows: UBO_PSPB > Forms > All Funds Budget. 
 

6. Confirm you can see four All Fund Budget forms: Budget Worksheet, Budget 
Worksheet-Level 0 Account, Control Amount Used and HCP Push Validation. 

 
7. Select your Entity, FundBudRefSOF, Dept Flex (if needed) and Program from the 

Point of View (POV) bar at top of screen, if not already displayed. 
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8. You are encouraged to use the Smart View forms in the same order as you did in 
Hyperion.  Please refer to procedures HCP Push Validation, Budget Worksheet or 
Budget Worksheet-Level 0 Accounts as needed. 

 
 

Input and Save Budget Data in Smart View 
As with Hyperion, you can enter or paste data into any open cell. 
 

1. Once you have entered data for all three budgets (Working Flat, Working Cut (if 
required) and Working Optimal), click Submit Data button to save and submit the data. 

 
NOTE: 
The unsaved data appears orange in Smart View. When data is submitted, the cell turns yellow.  
 
 

Copy, Paste and Cut 
The copy, paste and cut function are the same as those in Excel. 
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Adding Missing Accounts 
The adding missing accounts procedure allows you to add accounts that were not previously 
used but will be needed and used in the future. 

 

1. From the Planning tab, click the Calculate button on the Smart View ribbon. 
 

2. Click Rules on Form. 

 

3. Click the PopulateAccount Business Rule. 

 

 
In this example, we will use Account Code 772000. 
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4. Enter the appropriate Account code in the Select Accoun(s) field. 

 
5. Click the Launch button. 

 
This process may take a little while to run. 
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6. Confirm the launch was successful by noting the “Launch was successful” message that 
appears within the Busines Rule window. 

 

7. Once this message appears, click the Close button.  
 

 
 

8. Click the Refresh button on the POV toolbar. 
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9. Confirm the account displays in the worksheet. 

 
You can now begin budgeting for this account. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visable (as long as yo did not suppress zeros in your user 
preferences) for the current fiscal year. 

 
 

Adding Comments 
 

1. Right-click the cell to which you wish to add a comment. 
 

2. Hover over the Smart View menu option and click Cell Comments from the secondary 
menu. 
 

3. Enter comment into the Cell Comments window. 
 

4. Click the Save button. 
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5. Confirm the cell contains the comment by noticing the blue outline. 

 
 

Adding Supporting Details 
 

1. Right-click the cell to which you wish to add supporting details. 
 

2. Hover over the Smart View menu option and click Supporting Details button from the 
secondary menu. 
 

3. You will see similar menu items as those when you work in Hyperion. Please refer to 
Supporting Details section for steps to add, modify or delete supporting details. 

 
4. Confirm the cell contains the supporting details.  The cell will be highlighted blue/green. 

 
 

  



Hyperion Budgeting 134 

Control Amount Used 
This form is used to confirm that the total expense lines for both the Control and Working 
budgets equal.  After spreading budget dollars and before sending to CFO, you should confirm 
both budgets balance. 

 
If they do not equal, spread adjustments will need to be made prior to submitting to CFO. 
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Below screenshot shows the color coding for cells with comments, supporting details, and 
unsaved data.  Attaching documents using Smart View does not work if you need documents 
attached please do so within Hyperion. 
 

 

 

  

Cells with attached 
document  
have red outlines 

Cell with supporting 
details 

are highlighted in blue.

Cell with 
comments  
has blue outline. 

Cells with unsaved data are 
highlighted in orange. 
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Cell Formatting 

 
1. You can change the color coding in Smart View > Options > Formatting, uncheck “Use 

Excel Formatting”. 

 

2. Go to Cell Styles, right-click on the formatting to change the font, background or 
border. 
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Security 

The following myUFL security roles are created for users.  

 

UF_N_BP_COLLEGE_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 
college level. 

 

UF_N_BP_COLLEGE_VIEWER 
This role will grant access to view budget information in UF’s budget software at the college 

level 

UF_N_BP_DEPT_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 

department level 

UF_N_BP_DEPT_VIEWER 
This role will grant access to view budget information in UF’s budget software at the department 

level 

To have access to Hyperion application, the support unit users should request the 
UF_N_BP_COLLEGE_PLANNER role. 
 

Users have read and write access to their responsible areas only. For example, the VP and 
Chief Information Officer user can only view and input budget for all IT departments, not other 
areas like Finance and Accounting. The SVP areas have read access to all the areas under 
their umbrella. For example, the SVP for Academic Affairs and the Provost Office can view the 
budget of DOCE, Graduate School, Library, International Center, Enrollment Management, 
CFO, Purchasing, Contracts and Grants, Finance and Accounting, and Student Affairs. 
However, the SVP for Academic Affairs and the Provost Office can only input and modify budget 
for the Provost’s Office, not the other areas just mentioned.  
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UBO_PSPB All Funds Budget Application 
Overview 

Dimensions represent the key components of the application. The UBO_PSPB All Funds 
Budget application contains the following dimensions: 
 

 Account 

 Entity 

 Fund/Budget Reference/Source of Fund 

 Program 

 Dept Flex 

 Scenario 

 Version 

 Year 

 Periods 
 

Account 
The Account dimension in UBO_PSPB is based on the account structure in PeopleSoft 
Financial system. Not all GL accounts in PeopleSoft Financial system are included in 
UBO_PSPB since the support units do not budget to every single GL accounts. Only the 
GL accounts that have actual expenditure data in FY12 and FY13 are kept in 
UBO_PSPB. A few other GL accounts are also kept even though there is no actual 
expenditure data exists for FY12 and FY13. To see the Account dimension hierarchy, go 
to one of the three forms. Expand and collapse the account to see the details. 

 

The account dimension will be revised each fiscal year. 
 

Entity 
The Entity dimension in UBO_PSPB is based on the Department structure in PeopleSoft 
Financial system. It is modified to reflect the budget reporting hierarchy.  

 

Fund/Budget Reference/Source of Fund 
This dimension should reflect your fund budget reference and source of fund 
combination for your expenditures. 

 

Program 
This dimension should reflect your program. 

 

Dept Flex 
This dimension should reflect your department flex if used. 

 

Scenario 
This dimension shows the data is for Budget. 
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Version 
This dimension shows whether you are working on and should always be Working. 

 

Year 
This dimension shows the fiscal year. 

 

Periods 
This dimension shows the month of the fiscal year from July to June. 

 

 

 

 

 


